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INTRODUCTION 

This manual will help you get the most out of DiskFit. The Introduction gives you basic 
information about what DiskFit does. Chapter 1 provides step-by-step instructions for 
installing DiskFit. The rest of the manual provides instructions for backing up and 
restoring volumes, instructions for using tape, questions and answers, backup strategies, 
special considerations, troubleshooting, reference, a glossary, and an index. 

If You Don't Want to Read This Manual 
DiskFit was designed to be straightforward and easy to use. If you would like to get 
started immediately, copy DiskFit and DF.Help to your hard disk, and launch DiskFit. 
The application has complete on-line help if you need it. 

DiskFit's Answer to Backup Requirements 
DiskFit has many features for your backup requirements. Both DiskFit and Network 
DiskFit have the following features: 

• Backs up to any Macintosh® HFS volume: a hard disk, 3.5-inch HFS floppy disks, 
DTC/Kodak cartridges, Bernoulli cartridges, Syquest removable hard disk cartridges, 
read/write optical optical drives such as SuperMac's LaserFrame™, DC 2000 tape 
cartridges (provided that the tape drive has a 3M MCD 40 controller and the 
SuperMac™ TapeDriverTM file is in the System Folder), any other Macintosh HFS 
volume, or any combination of the above. 

• Does not require that you indicate which files have changed-just insert a disk or a 
tape and begin. 

• Keeps all backup files in Macintosh FinderTM-readable format, even on tape. You can 
access any file from the backup using the Finder. You do not have to launch DiskFit to 
access your backup files. 

• Automatically performs incremental backups. After the first backup, only files that are 
new or changed are copied, so you do not have to do a full backup every time. If you 
delete files on your source volume, DiskFit will always reclaim unused space on the 
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backup. This space is used for files that are new or different, so backups remain as 
compact as possible. 

• Uses the TapeDriver file to make backing up to tape as easy as backing up to any 
Macintosh disk. DiskFit is compatible with Apple Computer's Tape Backup 40SC, 
SuperMac's DataStream, DataFrame XP™40+40 and XP60+40, General Computer's 
HyperTape, and any other DC 2000 tape drives that use the 3M MCD 40 controller. 

• Backs up single files up to 2 gigabytes (2000 megabytes), automatically splitting them 
where necessary. Split files are joined automatically during restore and can be 
manually joined if desired. 

• Runs in the background under MultiFinder®. DiskFit uses the Notification Manager 
under Apple® system 6.0 (or later) to inform you when an additional disk or tape is 
needed. A special "attention" sound is played and the notification icon flashes over the 
Apple logo in the menu bar. If a backup is in progress and you choose Shut Down or 
Restart from the Finder's File menu, an alert appears to ask if you really want to stop 
the backup. Also, the desktop file can be backed up under MultiFinder, and restored 
under Finder, with all comments intact. 

• Allows you to create a Duplicate of your hard disk if the destination can hold all files to 
be backed up from the source volume. You can duplicate your entire hard disk or 
exclude certain folders from the Duplicate. You can duplicate to another hard disk, 
tape, an optical cartridge, a Syquest cartridge, a folder on another volume (provided 
that the folder is defined as a DiskFit Subvolume), etc. In a Duplicate, the folder 
hierarchy is retained, and backups are incremental. If you duplicate to another hard 
disk, you can have a complete ready-to-use Duplicate at all times. 

• Allows you to create a SmartSet if you are backing up to multiple Finder-ejectable 
volumes. In a SmartSet, the folder hierarchy is not retained on the backup media, but it 
will be reconstructed when you perform a complete restore from the SmartSet. Files 
are split when necessary and automatically joined during a restore. Split files can also 
be manually joined if desired. 

• Allows you to create multiple Duplicates or SmartSets and automatically numbers 
them. For details on Duplicates and SmartSets, please see Chapter 2,"Using DiskFit." 

• Allows you to limit a backup in one or more ways. You can create: 

-a SmartSet that backs up only documents; 

-a SmartSet that backs up only system files and applications; 
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-a SmartSet that backs up a single large file up to 2 gigabytes; 

-a SmartSet that backs up only the folders you specify; 

-a SmartSet that backs up everything except for certain types of files you specify; 

-a SmartSet that uses a combination of these file and folder limitations. 

In addition to these features, DiskFit: 

• Is extremely reliable. DiskFit will not consider a backup complete until each file is 
copied successfully. You can double-check that each file was precisely copied to the 
backup media using the Verify option. Each file is individually accessible from your 
backup, should any part of the backup be lost or damaged. DiskFit does not depend on 
any type of "directory" disk, since files are stored in Finder-readable format. 

• Creates a report each time you back up that logs the backup time and any errors, as 
well as a list of the backed up files and folders and the SmartSet volume(s) where the 
files are located. This report can be viewed and printed from DiskFit or from any 
word-processing application that will open a text file. 

• Preserves comments you enter in a file's Get Info box and keeps locked files locked. 

• Allows you to pause a backup and continue later. If you wish, you can also cancel a 
backup and later resume where you left off. 

• Allows you to define folders as Subvolumes for backup or restore purposes. This is 
particularly useful if users are backing up workstation files to a file server. 

Special Notes 

• Former DiskFit 1.4 Users: 
1) Ignore instructions regarding DataForm found in 1.4 release notes. DataForm has 
been eliminated and all tape formatting and initializing procedures have been integrated 
into the TapeDriver software. 
2) When you back up or restore with DiskFit 2.0 using a SmartSet that was created 
with an earlier version of DiskFit, the SmartSet will automatically be made into a 
DiskFit 2.0 set. The conversion only happens the first time you use the old set with 
DiskFit 2.0. All files will still be Finder readable. If you first use an older SmartSet in 
a backup, DiskFit will scan all disks and then proceed with the incremental backup. If 
you first use an older SmartSet in a restore, the restore will proceed as usual and the 
SmartSet will be automatically converted. 
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• DiskFit operates significantly faster with Apple's Control Panel RAM Cache on, We 
recommend setting it to 64K. However, setting the cache to a very large size (l ME, 
for example) could, under certain situations, reduce DiskFit's performance. Using the 
cache with DiskFit will not reduce reliability. 

• It's important that you use the latest version of Apple's System software. Although 
DiskFit is compatible with System 4.2 (or later), System 6.0.2 (or later) will allow you 
to take advantage of DiskFit's new features. If you are using an earlier System, contact 
your Apple authorized dealer for an update. 

• If you have installed a copy-protected program on your hard disk with a special 
installer program, you may need to reinstall the program or use a key disk after you 
restore your hard disk with DiskFit. 

• If you are using a 512K Macintosh with 64K ROMs and single-sided internal drive, 
you will need the HD 20 System File in your System Folder. 

• To access on-line help while running DiskFit from a file server, 512K Macintoshes 
with 64K ROMs must have Net.DF.Help, in their local System Folder. 

• DiskFit works with the Macintosh Plus or later. It does not work with the 128K 
Macintosh, the Macintosh XL/Lisa®, nor will it backup up MFS (nonhierarchical) 
volumes. 

DISKFIT USER'S MANUAL 



CHAPTER 1 

INSTALLING OISKFIT 

The DiskFit floppy disk contains a System Folder, the DiskFit application, the DF.Help 
file, and the Tape folder. If your hard disk ever crashes, you can start up from a copy of 
this disk to restore your files. 

Copying the Files onto Your Hard Disk 
• Insert the DiskFit floppy disk into a workstation Macintosh. 

0 DiskFit'M 2.0 0 
i 4 items 590K m dis!<- 196K available 

l1J S ~ 

System DiskFit 2.0 

0 ~ 
Tape DF.Help 

10 
101 IQ I2J 
DiskFit disk 

• Copy the DiskFit application to your hard disk, and copy the DF.Help file into the 
folder on your hard disk that contains the DiskFit application file, or into the startup 
System Folder. 

• If you are using a DC 2000 tape drive, locate the TapeDriver file in the Tape folder. 
Then copy the TapeDriver to the startup volume's System Folder. 

NOTE: You must have 650K offree contiguous disk space to use tape. Please see 
Chapter 4, "Using Tape," for details. 

The TapeDriver file must be in the startup volume's System Folder or DiskFit will not 
be able to read from or write to tapes. 
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NOTE: If your System Folder contains any other tape drivers, REMOVE them before 
installing the TapeDriver. 

• Once you have installed the TapeDriver software, turn on the tape drive and restart the 
Macintosh. 

The "Welcome to Macintosh" screen appears, and the startup icon pictured on the left 
should appear briefly on the screen: 

TapeDriver installed TapeDriver not installed 

If the icon on the right is displayed, or if no icon appears at all, the TapeDriver has not 
been properly installed. 

Make sure the TapeDriver is in the startup volume's System Folder and that it is not in 
another folder within the System Folder. Also, make sure the tape drive is connected 
and powered on before startup. Refer to Chapter 4, "Using Tape," for information on 
tape backup. 

• Make a copy of the DiskFit floppy disk, putting the TapeDriver file in the System 
Folder if you are using tape. You will use this disk to start up if you need to restore 
files to an empty or corrupted hard disk. 

• Store the original DiskFit disk in a safe place, away from heat, humidity, or anything 
magnetic. 
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CHAPTER 2 

USING DISKFIT 

We recommend that you read this chapter so you can use DiskFit most effectively. The 
following sections outline the procedures for beginning a backup, creating SmartSets and 
Duplicates, and using DiskFit's other features. 

About Duplicates and SmartSets 
DiskFit can create two different types of backups-Duplicates and SmartSets
depending on the backup media you are using and which files you wish to back up. Both 
Duplicates and SmartSets allow you to retrieve individual files. Both types will rebuild 
your hard disk to the state it was in after your last backup when you restore. 

Duplicates 
If you are backing up to a single destination volume, you can create an exact copy of your 
source volume, called a Duplicate. You can duplicate your entire hard disk or exclude 
certain folders from the Duplicate. The destination volume must be of equal or greater 
capacity than the source volume. If the destination is smaller than the source volume, 
you can use the Exclude [Folders] option to exclude folders so the contents will fit, then 
choose Disk Duplicate from the File menu to make the Duplicate. You can duplicate to 
another hard disk, tape, an optical cartridge, a Syquest cartridge, a folder on another 
volume (provided that the folder is defined as a DiskFit Subvolume), etc. In a Duplicate, 
the folder hierarchy is retained on the backup media. If you duplicate to another hard 
disk, you can have a complete, ready-to-use Duplicate at all times. 

SmartSets 
If you are backing up to multiple Finder-ejectable volumes, you will create a SmartSet. 
SmartSets allow you to specify exactly which folders or file types you wish to back up. 
In a SmartSet, the folder hierarchy is not retained on the backup media, but it will 
automatically be reconstructed during a restore. Files are split where necessary and are 
automatically joined during a restore. Split files can also be manually joined if you wish 
to retrieve them individually. 

You can back up just applications or documents, choose specific folders, or exclude 
certain files according to their type and creator codes. Any file or folder selections you 
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make are recorded in the information for that SmartSet. You can later change the folders 
and file selections of a SmartSet by choosing SmartSets from the Windows menu. 

Running DiskFit 
The procedure for creating either a SmartSet or a Duplicate begins by launching the 
program and choosing the source and destination volumes. 

• Double-click the DiskFit application icon to launch the program. The main window 
appears: 

t Backup D Restore 1 

A - __ ., Please select a d1Sk, 
Then choose 81 ther Backup or Restore 

s---

U d L \B k -------------------------------------
c--- 171 XP'" 20 [:lat~Fr_arn ... TM, S(SI E. 

l2:1 174"35r _792.t. O:un,'2.=op2 1q~O 524P~1 

DiskFit main window 

Rename ... 

[ Subuolume ... ] 

20 

The main window contains: [A] the message area; [B] the current volume area; [C] the 
available volume list; and [D] the volume buttons. 

The first message in the message area asks you to select the volume that you wish to back 
up or restore. The current volume area informs you about the progress of the backup. 
The highlighted volume in the list indicates the volume that will be backed up when you 
click Proceed. The volume buttons perform their functions on the selected volume. 

Choosing the Source and Destination Volumes 
To begin a DiskFit backup, you must first select the volumes you wish to work with. The 
volume you wish to back up is called the source volume and the volume(s) to which files 
will be copied is the destination. 

• Select the source volume in the volume list. Any volume appearing in the volume list 
can be a source volume. 
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The source volume can be a local disk or a Subvolume. For information about these 
types of volumes, refer to the sections "Defining a Subvolume" in Chapter 3 and 
"Using Subvolumes" in Chapter 6. (Note: A Subvolume can be particularly useful if 
you wish to restore files to a volume you do not wish to completely erase.) 

• Click Backup. 

The "Backup" button becomes "Proceed": 

n Proceed D Cancel 

I nsert/Sel ect the fl rst dest 1 nat lOn dl sk 
Pl ck: Proceed to cont 1 nue the Bac.kup 

. , 

: : 
," .. -. .j ;'.:. ::-: 

: . :': ., 
,,':"':;' . 
. '. : .~. . . 

DahFrame™, SCSI 6 . ' , 

Sun, Sop 2, 1990 5 24 Ptv1 

Selecting the destination volume 

Eject 

Rename ... 

Erase 

(Subuolume ... ) 

20 

• Select a new destination volume for a new backup, or an existing Duplicate or 
SmartSet for an incremental backup. The destination volume can be any volume that 
appears in the volume list that is not locked. 

• If you are backing up to floppy disks or another type of ejectable volume, insert the 
first destination disk into the appropriate drive and select it in the list. 

• If you are backing up to tape, insert a tape cartridge into the tape drive. DiskFit will 
inform you if the tape needs to be formatted or initialized, provided that the TapeDriver 
file is properly installed. For information on backing up to tape, refer to Chapter 4, 
"Using Tape." 

Make sure the correct destination volume is highlighted in the volume list. 
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• Click Proceed. The Backup Type dialog box appears, if the selected destination is 
large enough to contain the entire backup: 

~ Choose the Backup type: 

Duplicate - Smart coPy from one disk to another. 
Destination becomes identical to source. 

set - Copy files from one larger disk to multiple 
smaller disks, creating a SmartSet. 

Backup Type dialog box 

If Duplicate )) 

Set JIt 
Cancel 

If you are backing up to more than one destination volume, you will not see this dialog 
box. Skip to the section in this chapter "Creating a SmartSet." If the Backup Type 
dialog box appears and you wish to create a Duplicate, read the following section, 
"Creating a Duplicate." 

Creating a Duplicate 
If the capacity of your destination volume is greater than or equal to the capacity of your 
source volume, you can create a Duplicate of the source. In a Duplicate backup, the 
folder hierarchy is retained. You can duplicate an entire volume or you can exclude 
certain folders from the duplicate. 

You can also maintain an archive folder (one that will not be updated or erased) on a 
Duplicate destination, if there is room. Refer to the section "Exclude [Folders]" in 
Chapter 3 for information on this feature. 

When you click Duplicate in the Backup Type dialog box, you are asked to confirm that 
you wish to erase the destination volume, unless you have chosen Fewer Safeties in the 
Options menu. 

"'" Rre you sure you want to completely 
ill replace contents of 

"Of'" 40" (Dataframe 40, SCSI 103) 

with contents of 
"Of'" 20" (Data frame 20, SCSI 106) 

001 

Make sure you have chosen the correct source and destination volumes, and click OK. 

The DiskFit message area infonns you about the progress of the backup, and tells you 
when the backup is complete. 

DISKFIT USER'S MANUAL 



• When the backup is complete, choose Quit from the File menu to return to the Finder. 

Notice that DiskFit has closed any open windows on the destination to avoid confusion 
after the backup. Subsequent incremental backups using the same Duplicate 
destination will be extremely fast; DiskFit will only back up files that are new or have 
been changed since the last backup. 

Creating a SmartSet 
If you are backing up to a series of Finder-ejectable destination volumes, you will create a 
SmartSet. You can back up your entire source volume, or use one or more of the Folder 
Selection, Folder Exclusion, and/or File Exclusion features to limit a particular SmartSet 
backup. When you click Set in the Backup Type dialog box, or when you select a 
destination volume that is smaller than the source, the SmartSet dialog box appears: 

~ Creating a New SmartSet. 
~ (erasing disk "Milo 11"1 

IZI Hpplications 
IZI Documents 
o Single File 

Oack up applications and sy.tem files. 
Oack up all other types of files. 
Select and back up a single large file. 

Folder Selection... Default is to backup all folders. 

EHclude File.... I EHtlude. file. by type/creator. 

Name the set IQ"dll § 

SmartSet dialog box 

« New 11 

Cancel 

• Enter a new name for the SmartSet if you wish. 

• Click New to back up all your files to a new SmartSet. 

You can limit a SmartSet backup to just applications, just documents, or a single large 
file. Please refer to Chapter 3, "Selecting Folders and Files," for information on these 
features. You can also select certain folders you wish to include in the backup or 
specify types of files you wish to exclude from the backup. For more information 
on these features, refer to the sections "Folder Selection" and "Exclude Files" in 
Chapter 3. 

• After you insert each destination volume, click Proceed to continue (unless you have 
chosen Fewer Safeties in the Options menu.) 

• DiskFit automatically numbers all destination volumes in a SmartSet. NOTE: You 
should write the volumes' numbers on their labels if you plan to do incremental 
SmartSet backups, since DiskFit will ask/or the volumes by number. 
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The DiskFit message area tells you when the backup is complete. If the message 
indicates that the backup completed with errors, choose Error Log from the Windows 
menu to determine where the errors occurred. 

• When the backup is complete, choose Quit from the File menu to return to the Finder. 

During a SmartSet Backup 
This section contains general information about SmartSet backups. During the backup, 
DiskFit displays infonnation in the current volume area and in the message area. 

The message area infonns you about the operations in progress. The current volume area 
displays the volume being backed up, the next SmartSet volume number needed, the 
number and size in kilobytes (K) of the files copied and remaining, and the names of the 
files currently being copied. When another destination is needed, the current volume area 
displays the number of volumes you will need to complete the backup. 

Pause Cancel 

Wn t 1 ng to 1.DF HP™20 SmartSet 

Used 

XP- 20 

17584 K 

Fre. 

2642 K 

+ 1 .DF XP-20 SmartS .. t 
~EI .. '554'K' 861 K 

A SmartSet Backup 

Last Backup 

DataFrame™, SCSI 6 .. , ............. ,. 

Sun, Sop 2,1990 5 24 PM 

mt.mal dnv. 

2.0 

When DiskFit informs you approximately how many more destination volumes you will 
need, the number is calculated according to the size of the most recently used SmartSet 
destination volume. For example, if you are using both 800K and 1440K floppy disks in 
a backup, and you have just used a 1440K disk, the message tells you how many more 
1440K disks you would need to complete the backup using only 1440K disks. If you 
insert an 800K disk, the message indicates how many 800K disks you would need. 
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On the backup media, files will be put in whatever folder they were in on your hard disk. 
DiskFit keeps track of folders containing other folders. However, on a SmartSet volume, 
folders are not placed within other folders. For example, if you had a folder on your hard 
disk that contained two files and two folders, the SmartSet disk would contain three 
folders. Of course, when you restore your hard disk, the original folder arrangement is 
automatically recreated. 

SmartSet information is contained in two places. One copy is in a file called DiskFit 
Info, which is created automatically in the System Folder of your startup disk. The other 
copy is stored on each SmartSet volume. The copy in your System Folder helps you 
perform an incremental backup more quickly. If DiskFit Info is deleted or corrupted, the 
next incremental backup takes somewhat longer because DiskFit must rescan each 
SmartSet volume to rebuild the information. 

Incremental SmartSet or Duplicate Backups 
Incremental backups are extremely fast and easy. All you have to do is follow the 
instructions for a backup and select the existing SmartSet or Duplicate as the destination 
volume. 

In an incremental Duplicate backup, select the destination in the DiskFit volume list when 
you are asked to select the destination volume. DiskFit will only update the changed or 
new folders and files. 

NOTE: If you addfiles to your hard disk so that there is no longer enough room on the 
Duplicate destination volume, you will be asked to create a new SmartSet backup. 

In an incremental SmartSet backup, you should insert the first disk in the SmartSet when 
you are asked to select the destination volume. During an incremental SmartSet backup, 
the contents of the source are compared with the contents of the destination. DiskFit only 
requests SmartSet volumes containing files that have changed on the source volume, so 
incremental backups are extremely fast. 

The next SmartSet volume that will be requested 

The current volume area 
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The number to the right of the source icon in the current volume area corresponds with 
the next volume that will be requested, so you can look for the next labeled volume while 
the previous one is being used by DiskFit. 

If the files on your source volume will not fit on existing SmartSet volumes, DiskFit 
informs you approximately how many more destination volumes you will need. 

Missing or Defective SmartSet Volumes 
If you are missing any SmartSet volume during an incremental backup, even if it is the 
first volume, simply insert the next volume in the series. DiskFit will ask you if you are 
really missing the volume(s). Click Missing and DiskFit will recopy the information 
onto a new volume. 

If you are missing any SmartSet volume during a restore, even if it is the first volume, 
simply insert the next volume in the series. DiskFit will ask you if you are really missing 
the volume(s) that came before it, and continue to restore the files on all of the available 
volumes. You will only lose the files that were on the missing volume, since DiskFit 
doesn't depend on any type of catalog information to restore files. If a disk is unreadable, 
you may try to use a data recovery program to repair the disk. 

If a disk or tape produces read or write errors during a backup, a dialog box will appear 
asking whether you want to continue using the questionable volume or rebuild the 
information on a more reliable one. If you have extra destination volumes, click Rebuild 
and insert a new one. DiskFit will not consider a backup complete until all selected files 
from the source are successfully backed up to the SmartSet. 

Converting Old SmartSets to 2.0 Format 
When you back up or restore with DiskFit 2.0 for the first time using a SmartSet created 
with an earlier version of DiskFit, the SmartSet will automatically be converted into a 
DiskFit 2.0 set. The conversion only happens the first time you use the old set with 
DiskFit 2.0. All files will still be Finder readable. 

If you first use an older SmartSet in a backup, DiskFit will scan all disks and then 
proceed with the incremental backup. If you first use an older SmartSet in a restore, the 
restore will proceed as usual and the SmartSet will be automatically converted. 

Updating Old SmartSet Volumes 
You may want to update an out-of-date SmartSet that contains files similar to those on 
your hard disk. If you have not done so already, follow the instructions in the section 
"Changing or Deleting SmartSet Information" in Chapter 3. DiskFit will no longer think 
that these volumes are part of another set. If you then insert one of these unknown 
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volumes whose name begins like a SmartSet disk (following the pattern" 1.SmartSet"), 
the following dialog box appears: 

You are now backing up. 

"My Ba(kup" is not a known SmartSet. 
Scan all di~ks to rebuild it? 

Yes - preserue set's files still on the source. 
No - create a new set. erasing the disks. 

If you click Yes, DiskFit scans the SmartSet for files similar to those on the source 
volume, and update the SmartSet so its files will be identical to those on your source. 

If you do not wish to scan the SmartSet for similar files, click No. The SmartSet disks 
will be erased and treated as new disks. 
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CHAPTER 3 

SELECTING FOLDERS AND FILES 

DiskFit allows you to limit backups by selecting or excluding folders and/or file types. 

Most of this chapter is devoted to limiting a SmartSet backup. However, note that the 

Folder Exclusion feature applies to both Duplicates and SmartSets. This chapter also 

explains how to define a folder as a Subvolume for backup purposes. 

Limiting a SmartSet Backup 
When you are creating a SmartSet, you can limit which files are backed up using the 

check boxes and/or Folder Selection and Exclude Files buttons in the SmartSet window. 

You can create separate SmartSets for different types of files or for certain folders, or you 

can exclude certain files by Type and Creator codes. 

~ Creating a New SmartSet. 

~ (erasing disk "Milo II ") 

[SJ Rpplications 
[SJ Documents 
o Single File 

Back up applications and system files. 

Back up all other types of files. 

Select and back up a single large file. 

Folder Selection... Default is to backup all folders. 

Ellclude Files... I Ellcludes files by typeicreator. 

Name the set 1",,611,m 
SmartSet dialog box 

I[ New J 
[ Cancel 1 

• If you do not wish to include document files in this SmartSet, uncheck Documents. If 

you do not wish to include applications and system files, uncheck Applications. 

• To back up a single large file (up to 2 gigabytes), check Single File. A standard 

Directory dialog box appears, allowing you to select the file you wish to back up. 

• To select folders for backup, click Folder Selection, and refer to the following section, 

"Folder Selection," for instructions. 
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• To exclude certain types of files, click Exclude Files, and skip to the section "Exclude 
Files" for instructions. 

NOTE: You can use both folder selection and file exclusion in the same backup. 

• When you have selected the folders and files you wish to back up, click New to 
proceed. DiskFit will ask you to confirm that you wish to erase the destination volume 
unless you have chosen Fewer Safeties from the Options menu. 

Folder Selection 
When you click Folder Selection from the SmartSet window, DiskFit scans the source 
disk for folders, and the Folder Selection Window appears. In this window, the folders 
on your source volume are listed hierarchically. No files appear in the window. 
In the Folder Selection window pictured here, notice folders A, B, and C: 

~ Please select the folders to bark up... n OK l 
l.:L;J Only files in highlighted folders are barked up.' • 

c::JHilo 

o It 10K 

DB 
Dc 

D Applications 

o Dabbase etc 

D LAYOUT 

o DesignStudio 

D Annex F 0 IdeI'" 

o Dictionary Folde,. 

o RSG stuff 

o Macflo,..- 3.0'.3 

o Samp I"" Flowcharts 

o HUL T Istuff 

Folder Selection window 

Ok 

OK 

322 K 

2025 "-

890 K 

7.20 K 

1361< 

217 K 

1'::15 J<.. 

331 k 

86 f... 

138 K 

[ancel 

[ Select All I 

(fear 

The illustration above represents the folders on a local hard disk. If you are selecting 
folders on a server, folders to which you have no access appear grayed. You cannot copy 
files from grayed folders. 

DiskFit's Folder Selection window allows you to specify folders to include in a SmartSet. 
Each folder must be selected individually. When you select a folder in the 
Folder Selection window, only the files within it are backed up; if the chosen folder 
contains a nested folder, the nested folder's contents will not be included unless you 
select that folder also. The following is an example of how folder selection works: 

Let's say folder "A" contains four items: two other folders "B" and "C," and two files, 
"Picture I" and "Picture 2." In the Finder, folders A, B, and C looked like this: 
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0 A 0 
41tems 66,563K In dlSk 585K avalla 

0 0 
~ 

B C 

~ ~ 
p,cture 1 p,cture- 2 

~ 
K;JI Ie;: 121 

If you select folder A for backup by highlighting it, folder A's contents, Picture 1 and 
Picture 2, will be copied to the SmartSet. (Note: Folders Band C will not be copied 
unless they are selected separately.) 

• In the Folder Selection window, select the folders to include by clicking them. 

If you plan to select most of your folders, you can click Select All, and deselect folders 
by clicking them. To deselect all folders, click Clear. 

• When you have selected the folders you wish to include, click OK. The SmartSet 
window reappears. 

• If you wish, you can also use any other backup limitation features. Any other 
limitations you specify will only be applied to files within the folders you selected in 
the Folder Selection window. 

• Click New to proceed with the backup. 

The folders you selected will be copied to the SmartSet. The DiskFit Report contains a 
listing of these folders. (Note: Files will also be included in the report, if Expanded 
Report in the Options menu remains checked. Expanded Report is the default setting on 
your original program copy.) You can select View Report from the Windows menu, and 
Print Report from the File menu, or you can open and print the report from a word
processing program that reads text files. 

Exclude [Folders] 
DiskFit also allows you to specify folders that you do not want to include in a backup. 
You may want to do this if your destination volume will not hold the entire contents of 
your source volume. For example, if you wish to back up your source hard disk to 
another hard disk or a tape which is not large enough to hold the entire source, you may 
exclude enough folders from the backup using the Exclude [Folders] feature so the 
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backup will fit. When enough folders have been excluded, you can choose Disk 
Duplicate from the File menu (to "force" the Duplicate), or create a SmartSet. To 
exclude folders: 

• Using the Finder, type brackets around the name of any folder you wish to exclude 
from the backup. For example you would change the name of the folder called 
"Utilities" to "[Utilities]" on your source volume. 

• Launch the DiskFit application. 

• Choose Exclude [Folders] from the Options menu. 

Now any folders whose names are bracketed will automatically be excluded from the 
backup. If you wish to periodically back up these folders, you can uncheck Exclude 
[Folders] or remove the brackets from the folders you wish to back up. 

If you later wish to include the previously excluded folders, you can either deselect the 
Exclude [Folders] option, or remove the brackets from any folders you wish to include. 

IMPORTANT NOTE: The Exclude [Folders] option also allows you to create archive 
folders on a Duplicate destination (but not on a SmartSet). Please read the following 
section for information if you are creating a Duplicate and using thisfeature. 

Archive Folders on a Duplicate Destination 
Use this option with caution for the following reasons: 

1) You can only create archive folders on a Duplicate destination volume. Do not try to 
create excluded folders on a SmartSet destination of any type since DiskFit will not 
acknowledge that the folders are excluded, and they will be erased. 

2) If you are excluding folders from a backup as described in the previous section, 
"Exclude [Folders]," note that deselecting this option will cause any archive folders on 
the destination to be erased. 

Normally DiskFit erases any files on a Duplicate destination that no longer exist on the 
source, and updates folders that have changed since the last backup. The Folder 
Exclusion option allows you to create an archive folder (that is, one that will not be 
erased or updated) on a Duplicate destination disk. You may wish to store archive folders 
on a Duplicate destination disk if there is extra space on it. 

For example, if you have a 20 MB drive in your SE and wish to Duplicate to a DataFrame 
XP40, you may create a folder with brackets around the name (such as "[Archive]") on 
your XP40 and store files there. These folders will not be updated or erased during a 
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Duplicate--even though they may have changed or no longer exist on the SE's 20 MB 

disk. 

To create an archive folder on a Duplicate Destination: 

• Using the Finder, type brackets around the name of a folder on the destination volume. 

You can create a new folder or change the name of an existing one. For example you 

would change the name of the folder called "Archive" to "[Archive]" on your 

destination volume. 

• Launch the DiskFit application. 

• Choose Exclude [Folders] from the Options menu. 

Now any folders on the destination whose names have brackets will be preserved during 

Duplicate backups. 

If you wish to remove an archive folder, simply remove the brackets from the folder 

name or deselect Exclude [Folders] in the Options menu. When you later back up to that 

destination, the archive folder will be erased. 

Instead of using excluded folders, you can create an "archive" backup. Simply perform a 

backup and store that backup in a safe place. However, be careful not to reuse this 

backup if you wish to keep a permanent archive. 

Exclude Files 

DiskFit's File Exclusion window allows you to automatically exclude specific types of 

files from a SmartSet, using the four-letter Type and Creator codes assigned to each 

Macintosh file. 

A document's Creator code is what tells the Macintosh which application to launch when 

you double-click the Document icon. For example, when you double-click a document 

you created in MacDraw® II, the Macintosh looks at the creator code, locates a copy of 

the MacDraw application, and launches the program. 

A document's Type code is what allows several applications to open a particular kind of 

file. For example, if you create a PICT file with MacDraw II, you can also open it from 

within another application, such as PixelPaint Professional® that will open PICT files. 
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When you click Exclude Files from the SmartSet window, the Exclude Files dialog box 
appears: 

[llcluded files matching type and/or creator ... 

Type (reator 
Hila [i .... '"'16 n OK ) 
{"my, (1/00 
I/OP/l flOP! Cancel ;-;-??? IITU( 
iOJiE 1.O/O/P 
{JOU! .YL'fI 
tiP" / tlfisA H~~~no~jp 

SliflP {ltfEII iii 

[ Rdd from a file ... ] Gets typeirreator from a file 

[ Rdd manually... ] Manually adds typelcreator 

Exclude Files dialog box 

The Exclude Files window already contains a list of Type and Creator codes in italics. 
These codes correspond to files that are automatically excluded from every backup. They 
cannot be removed. DiskFit 2.0 will automatically exclude partition files created by 
FWB's Hard Disk Partition, SUM's HD Partition, Infosphere's MacServe, ALSoft's 
MultiDisk, and Connectix's Virtual Swap. Please see "Partitioned Hard Disks" under the 
section "Special Considerations" in Chapter 6 for details. 

You can add your own Type and Creator codes to the list, either by matching those of an 
existing file or by typing them. The codes you add to the list will appear in plain text, 
and they can be removed. Note that all files corresponding to codes you add to the list 
will be excluded from all backups to this SmartSet, not just the highlighted ones. 

As an example, let's say you wish to exclude MacDraw II PICT files from your backup . 

• Click Add from a file in the File Exclusion window. A Directory dialog box appears: 

[E Select Flle wlth Type/Creator to add to I1St 

10 A I 
DB Q ~Milo 
DC 

• [ iF'! ) 
D Picture 2 ( Drille ) 

[ Add ) 
{} I Cancel ) 
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• In this example, we will select any MacDraw II PICT file. 

• Click Add. The File Exclusion window reappears with the Mac Draw II PICT type and 
creator codes highlighted in the list. 

• Click OK to exclude all MacDraw II PICT files from the backup. The SmartSet 
window reappears. 

• Click New to proceed with the backup. 

As another example, let's say you wish to add a Type or Creator code manually. 

• Click Add manually in the Exclude Files window. The following dialog box appears: 

Manually add typeicreator to list... 

type 

creator 

OType only 

o Creator only 

@Both 

Cancel 

• If you wish to match all files of one Type, regardless of their Creator codes, select 
Type only. If you wish to match all files of one Creator, regardless of their Type 
codes, select Creator only. 

• Enter the code or codes you wish to add. 

• Click Add. The File Exclusion window reappears, with the codes you entered 
highlighted in the list. 

• Click OK to exclude this type of file from the SmartSet backup. The SmartSet window 
reappears. 

• Click New to proceed with the backup. 

Changing or Deleting SmartSet Information 
You can change any of the folder and file selections of an existing SmartSet. You can 
also delete the SmartSet information if a SmartSet is no longer needed. If you delete the 
information, DiskFit will no longer recognize those SmartSet disks as part of an existing 
set, so they can be used in another set. To change the settings or delete the information: 
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• Choose SmartSets from the Windows menu. The SmartSets dialog box appears: 

o SmartSets™ 

Smart (::,et 

Uolume DataFrame'M 20 
Attributes (all files) 

Updated 
Size 
Utilization 

Sat, Sep 15, 1990 1:43 PM 
67523 K disks 
16221 K 24 10 

Changing or deleting a SmartSet 

[Folder Selection ... ] 

EHclude Files ... 

Delete Set Info 

• If you wish to delete the infonnation click Delete Set Info. 

• If you wish to change the currently selected folders, click Folder Selection and refer to 
the section "Folder Selection" in Chapter 3. 

• If you wish to change the currently excluded files, click File Exclusion and refer to the 
section "Exclude Files" in Chapter 3. 

Defining a Subvolume 
A Subvolume is a folder you define as a volume to be used as a source or destination 
volume for backup and restore purposes. When you use a Subvolume as a source, you 
can create a SmartSet or a Duplicate backup. When you use a Subvolume as a 
destination, you must create a Duplicate backup. (This is because SmartSet destination 
volumes must be Finder ejectable.) 

You can define a subvolume on any volume that appears in the DiskFit volume list. 
Using a subvolume minimizes memory usage, and is particularly useful if you wish to 
restore files to a volume you do not wish to completely erase. See "Using Subvolumes" 
in Chapter 6 for more infonnation on how and when to use Subvolumes. 

OISKFIT USER'S MANUAL 



You could define a Subvolume on a file server and back up or restore files to it. You 
could also create a folder on your hard disk called "Backup Folder" and define it as a 
Subvolume. These folders would then appear in the DiskFit volume list, and you could 
select them as you would select any other source or destination. To define a folder as a 
subvolume: 

• From the DiskFit main window, highlight the volume on which you wish to create a 
Subvolume. 

• Click Subvolume. A standard Directory dialog box appears. 

• Highlight the folder you want to define as a subvolume. 

• Click Define. The Source window reappears with the subvolume highlighted in 
the list. 

• Click Proceed to continue with the backup. 

If you wish to remove a volume definition, highlight the subvolume in the Source list, 
and click Release. Note: If you drag a Subvolume folder into the Trash, it will be 
dimmed in the DiskFit volume list. To remove it from the volume list, highlight it and 
click Release. 

If you wish to restore files to a destination you do not wish to erase, you should create a 
new folder using the Finder and define it as a Subvolume. 

NOTE: A sub volume and its parent volume are treated as separate entities, but files in a 
Subvolume are not necessarily excluded from the parent volume. If you back up the 
parent volume, the backup date for the subvolume will not be set, but the Subvolume's 
contents will be backed up in the parent volume backup. 
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CHAPTER 4 

USING TAPE 

DiskFit makes backing up to tape as easy as backing up to another hard disk. Tape 
cartridges are treated like Finder-readable Macintosh disks, so you can select them from 
the volume list as you would any destination volume. The TapeDriver software tells your 
Macintosh how to communicate with DC 2000 tape drives that use the 3M MCD 40 
controller, such as Apple's Tape Backup 40SC, and SuperMac's DataFrame XP40+40 
and XP60+40 systems. 

Installing the TapeDriver 
• If you have not already done so, copy the TapeDriver file into the startup volume's 

System folder of the Macintosh to which the tape drive is attached. 

The TapeDriver file must be in the appropriate System Folder or DiskFit will not be 
able to read from or write to tapes. 

NOTE: If your System Folder contains any other tape drivers, REMOVE them before 
installing the TapeDriver. 

• Restart the Macintosh, and make sure the TapeDriver startup icon appears briefly on 
your screen: 

TapeDriver installed TapeDriver not installed 

If the icon on the right is displayed, or if no icon appears at all, the TapeDriver has not 
been properly installed. Make sure the TapeDriver is in the appropriate System Folder, 
and that it is not in another folder within the System Folder. Also, make sure the tape 
drive is connected and powered on before or during startup. 
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• Make a copy of the DiskFit floppy disk, putting the TapeDriver file in the System 
Folder. You will use this disk to start up if you need to restore files from tape to an 
empty or corrupted hard disk. 

Formatting a Tape Cartridge 
Tapes must be formatted and initialized to be used with DiskFit. DiskFit recognizes 
whether your tape is formatted or initialized, and prompts you accordingly. 

Formatting takes about 40 minutes, during which the tape is completely erased. 
Initialization takes about one minute, during which the TapeDriver makes the tape into a 
Finder-mountable volume so you can select it in the DiskFit volume list. 

Backing Up to Tape 
When you insert a formatted and initialized tape, it takes about a minute to appear in the 
DiskFit volume list or on the Macintosh desktop. Because it takes much longer to access 
data from a tape than from a hard disk, avoid launching applications from the tape. Using 
the Finder, you can copy individual filesJrom the tape, but avoid copying files to the 
cartridge using the Finder. 

When you run DiskFit, backing up to tape is just like backing up to any Macintosh disk. 
Select the source volume, click Backup, select the tape cartridge, and click Proceed. If 
your entire source will fit onto the tape, you can create a Duplicate. If your source will 
not fit onto the tape, or if you want to back up selected files or folders, you need to create 
a SmartSet. 

When you have selected the backup type, a dialog box appears giving you an opportunity 
to delay the start of the backup: 

Tape copying delay 

Wait I~I minutes before 
continuing ... 

K OK;] 
'> top) 

( cancel) 

Since the tape mechanism can be quite noisy during the backup process, an immediate 
backup might be inconvenient. The delay enables you to instruct DiskFit to begin the 
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backup later-for example, at the end of the day after everybody has left the office. Type 
in a delay if you wish, and click OK. 

NOTE: You can also use the delay feature with other types of backup media. After you 
select the destination volume, type command-T. You should then see "(tape)" to the right 
of the destination volume name. When you then click Proceed, the delay dialog box will 
appear. If you do not wish the delay dialog box to appear, select the destination, type 
command-T again, and "(tape)" will disappear. 

The first time you back up to tape, it takes about one minute per megabyte to copy files 
from your hard disk to tape. Subsequent incremental backups will be much faster, 
because DiskFit only backs up data that has been added or changed. DiskFit also 
removes from the tape any files you have removed from the hard disk. After 
an incremental backup, the contents of the tape exactly resemble the contents of your 
hard disk. 

Subsequent incremental backups work as described previously in this manual. When 
DiskFit asks for a destination volume, insert the tape that contains the Duplicate, or insert 
the first SmartSet tape. If you add files to your hard disk so that it now contains more 
than your Duplicate tape can hold, you will need to create an entirely new backup using 
DiskFit's SmartSet option. If your hard disk now contains more files than will fit on your 
SmartSet tapes, DiskFit will request an additional tape. 

Ejecting a Tape Cartridge 
When the backup is finished or another tape is needed, DiskFit asks you to eject the tape. 
Do not eject the tape before the dialog box requests you to. Be sure to write the date and 
the appropriate name on the cartridge label, as you would with any backup. Follow these 
steps to eject a tape: 

• Select the tape in the DiskFit volume list and click Unmount, or drag the tape icon into 
the Trash using the Finder. 

• Wait while the Macintosh prepares to eject the tape. When the tape is ready to be 
ejected, this message box appears: 

Please eject the tape cartridge ... 

WARNING: Ejecting a tape before this message appears may lead to data loss. 

USING TAPE 29 



30 

• Eject the tape according to the tape drive manufacturer's instructions. 

NOTE: Selecting Shut Down or Restart when there is a tape in the tape unit will also 
initiate the eject sequence. 

Locking and Unlocking a Tape Cartridge 

Tape cartridges, like 3.5-inch disks, have a sliding tab that allows you to write protect the 
tape, so no files on it can be accidentally changed or deleted. You may want to lock any 
permanent archive tapes as a precaution. 

Write-protect tab 

Write-protect tab in unlocked position 

Unlock a tape by sliding the write-protect tab away from the center of the tape as shown 
in the diagram above. Lock a tape by sliding the tab toward the center of the tape. 

Special Notes for Tape Backups 
DiskFit's tape backup capability works under MultiFinder. However, when running 
DiskFit in the background, there will be significant pauses in the foreground operations. 
This results more from the way tape works than anything specific to DiskFit. We suggest 
that you leave DiskFit in the foreground when you back up to tape. Of course, you may 
always Pause the backup, send DiskFit to the background, and proceed later. 

IMPORTANT NOTE: When the TapeDriver is in the System Folder, afile called 
"%%TapeCache%%" should be created when you first insert a tape. If you do not have 
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650K of contiguous space on your hard disk, this file will not be created, and operations 
to tape will be extremely slow. If the file is not created, either use a disk defragmenting 
program or archive some large files to create space for the cache file. 

Restoring Files from Tape 
DiskFit's Restore command lets you quickly and easily copy all the files from tape to 
your disk. If you need to restore only one or two files from a tape, just use the Finder to 
copy the files from the tape to your hard disk. 

Particularly when restoring an AppleShare® server, you should first initialize the hard 
disk to which you will be restoring. Use DiskFit's or the Finder's Erase command or see 
the instructions in your hard disk manual to initialize it. 

If you are restoring files from tape to a completely empty disk, you may need to start up 
from a floppy disk that contains DiskFit and has the TapeDriver file in the System Folder. 

To make a DiskFit floppy disk and start up from it: 

• Create a System folder on a floppy disk, and copy a System, the Finder, and the 
TapeDriver file into the System Folder. 

• Copy the DiskFit application onto the floppy disk. 

• Shut Down your Macintosh and switch off the hard disk. 

• Insert the DiskFit disk in the Macintosh floppy disk drive. 

• Switch on your hard disk, wait 15 seconds, and then switch on your Macintosh. The 
TapeDriver icon should appear briefly on the screen, and then the DiskFit floppy disk 
icon should appear in the upper-right corner of the desktop with the hard disk icon 
below it. 

• Double-click the DiskFit icon to launch the program. 

• Select the hard disk to be restored in the DiskFit volume list. 

• Click Restore. 

• Insert the tape containing your files. If you are restoring files from a multiple-tape 
SmartSet, insert the first tape in the SmartSet. The tape icon will take about a minute 
to appear in the volume list. 
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• Click Proceed. If you are restoring the files from a tape containing a Duplicate of your 
hard disk, a dialog box to confirm the Restore command may appear. If so, click OK. 

The time delay dialog box appears: 

Tape copying delay 

Wait I~I minutes before 
continuing ... 

• If desired, enter a time delay and click OK. 

( cancel) 

NOTE: You can also use the delay feature with other types of backup media. After you 
select the destination volume, type command-T. You should then see "(tape)" to the 
right of the destination volume name, even though you are not using tape. When you 
then click Proceed, the delay dialog box will appear. If you wish to remove the delay 
feature, type command-T again, and "(tape)" will disappear. 

The rest of the restoration process will be automatic. If you are restoring from a 
multiple-tape SmartSet, DiskFit will request other tapes as required. When the restore 
is complete, the message "Restore to Hard Disk was successful" will appear. 

• Choose Quit from the File menu to return to the Finder. 
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CHAPTERS 

RESTORING 

Restoring rebuilds the information on your disk using a SmartSet or a Duplicate. The 
Restore command allows you to recreate your disk exactly as it was the last time you 
performed a backup. If you wish to restore just a few files, refer to the section in this 
chapter "Restoring a Few Files." 

About Restoring 
Your disk may actually speed up after a DiskFit Restore. This is because any files that 
have become fragmented (stored in various small pieces) will be copied in contiguous 
areas which are faster for your hard disk to read. If your disk becomes sluggish, you may 
want to back up and restore your hard disk just to defragment your files. Backing up and 
restoring can also correct certain file system problems. 

(Note: We strongly recommend that you make two backups before you erase your hard 
disk.) Before restoring, we suggest that you first format your disk with the formatting 
utility supplied by the manufacturer of your hard disk. 

If you have an Applications and System files SmartSet and a Documents SmartSet, 
restore the Applications set before the Documents set. Restoring files in this order will 
keep your files from fragmenting extensively so your hard disk will continue to perform 
optimally. 

Restoring an Entire Volume 
To restore an entire hard disk, you should first create a DiskFit startup floppy disk by 
copying DiskFit onto a floppy disk, and copying a System and the Finder into a System 
Folder on the floppy disk. If you are restoring from tape, make sure the TapeDriver is 
also in the System Folder. Then, follow the rest of the instructions in this section. 

To Restore an entire volume: 

• Shut down the Macintosh. 

• Start up the Macintosh with the DiskFit startup floppy disk. 
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It is best to always run from the same floppy disk while restoring, since information 
that speeds the restore is stored in the DiskFit Info file in the floppy disk's System 
Folder. 

• Launch the DiskFit application from the startup floppy disk. 

• Select the volume that you wish to restore by clicking on it in the volume list. 

• Click Restore. Do not press the Return key yet. 

• If you are restoring from a SmartSet, insert the first disk in a SmartSet. 

• If you are restoring from a Duplicate, select it from the volume list. (Note: If you have 
been duplicating to a hard disk and your source and Duplicate disks are named alike, 
be careful not to duplicate the source disk onto the Duplicate inadvertently. You can 
tell the difference by looking at the "last backed up" time in the volume list.) 

• Click Proceed. 

• If you are restoring from a SmartSet, insert each SmartSet disk as requested. Once you 
have inserted the last disk in the SmartSet and DiskFit asks for another, click Missing 
and then Done. The message "Restore completed successfully" will appear. 

Restoring a Few Files 
If you want to restore only a few files (and "Expanded Report" was selected in the 
Options menu during the backup), the best method is to check the DiskFit Report file for 
the files' locations as described in this section, and copy the files to the your disk using 
the Finder. See Chapter 8, "Reference" for more information on the DiskFit Report file. 

To open a report from DiskFit: 

• Launch the DiskFit application. 

• Choose View Report from the Windows menu. A Directory dialog box appears. 

• Locate the Report file in your System folder and open it. If you wish, you can print the 
report by choosing Print Report in the File menu. 

• Locate the backup volumes containing the files you wish to restore. 

• Insert the volumes, and copy the files onto your disk using the Finder. 
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• If any files are split between volumes, they will appear with Split File icons. To join a 
file, copy all the pieces of the file into an empty folder on your disk, launch DiskFit, 
and choose Join Files from the File menu. 

NOTE: You can also open a DiskFit Report with any word processing application that 
reads text jiles. This might be handy ({you need to search for a particular file name and 
the application has a search feature. 

Using a Duplicate Hard Disk 
If you have been Duplicating a hard disk to another hard disk, and something happens to 
the original, you may start up and use the backup hard disk directly. This is particularly 
convenient if your original drive needs to be physically repaired. 

If the original hard disk had a software or file system problem, you may wish to 
reinitialize (format) it and then Duplicate to it from the backup hard disk. When copying 
from one hard disk to another, there is no real difference between clicking Backup and 
Restore. WARNING: Be careful not to Duplicate the corrupted original to the backup 
hard disk. 
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CHAPTER 6 

BACKUP STRATEGIES AND 
CONSIDERATIONS 

This chapter offers suggestions for backup strategies and covers special considerations 
for using DiskFit. The last section in this chapter answers some commonly asked 
questions about DiskFit. 

Backup Strategies 
If you do not already have a backup strategy, it is a good idea to adopt one as part of your 
normal work routine. The simplest backup strategy is the daily, weekly, or monthly 
backup. The more often you back up, the less there is to lose, but only if nothing happens 
to the backup disks. A fire, for example, could destroy both the original hard disk and 
backup disks. 

A secure strategy consists of daily and weekly backups to different sets of disks or tapes, 
with the weekly backups kept off site. That way, even in the worst case, only a week's 
worth of work will be lost. Another backup strategy is daily or weekly alternating 
backups, first to one backup set, then to another. You could even have three or more sets 
and rotate among them. It is important to decide what level of data security you require, 
and use a backup strategy consistent with your needs. 

DiskFit allows you to limit backups in several ways. See Chapter 3, "Selecting Folders 
and Files," for information on this feature. 

Since DiskFit supports backing up to tape or to another hard disk as well as to floppy 
disks, other possibilities exist. You could back up to a floppy disk SmartSet weekly or 
monthly and to tape daily. 

Whatever strategy you use, DiskFit creates and maintains as many SmartSets as you need 
quickly and easily. 
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Using Subvolumes 
Subvolumes can enhance your backup strategy for backups and restores. You could 
define a Subvolume on another hard disk and Duplicate your hard disk to the Subvolume. 
This would allow you to use any free space on the destination drive for other purposes. 
You could also define a Subvolume on your source disk as a "Backup Folder." You 
could copy into it any files you wish to back up, and create a SmartSet or a Duplicate of 
the Subvolume. 

Unattended Backups 
DiskFit has three features to facilitate unattended backups. You can delay the backup, 
automatically shut down after backup, and/or can configure DiskFit for use with a floppy 
disk loader. 

• Backup Delay: You can use the delay feature with any type of backup media. After 
you select the destination volume, type command-T. You should then see "(tape)" to 
the right of the destination volume name. When you then click Proceed, the Delay 
dialog box will appear. If you do not wish the Delay dialog box to appear, select the 
destination, type command-T again, and "(tape)" will disappear. See the section 
"Backing Up to Tape" in Chapter 4 for more information. 

• Automatic Shutdown: If you hold down the Shift key when you click Backup, you 
will hear a beep signifying that DiskFit will shut down after the backup is complete. 
USE WITH CAUTION! Any open documents will not be saved at shutdown. 

• To use an Automatic Floppy Disk Loader for unattended SmartSet backups: 
-For the first backup using unformatted floppy disks, check the Auto Format 

and Fewer Safeties options. 
-For the first backup using empty formatted floppy disks, check the Fewer Safeties 

option. 
-For the first backup using a combination of empty formatted and unformatted 

floppy disks, check the Auto Format and Fewer Safeties options. 
-For all incremental backups, check the Scan Every Disk and Fewer Safeties 

options. 

Note that DiskFit will only use disks that 1) are named as part of the SmartSet you are 
using OR 2) are empty (erased). The Fewer Safeties option allows you to bypass 
dialog boxes that normally require you to click Proceed before using an empty disk in 
a SmartSet. Since these dialog boxes will interfere with unattended backups, this 
option must be checked if you are using a floppy disk loader. Please see Chapter 8, 
"Reference" for information on this option. 
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Special Considerations 
This section contains a discussion of several points of special interest: Using the RAM 
Cache, Partitioned Hard Disks, Files Contained in an Applications or Documents 
SmartSet, Invisible Files, and Contiguous Files. 

• Using the RAM Cache 
DiskFit will be significantly faster if the Control Panel RAM cache is on. 64K is the 
recommended size. Using the cache with DiskFit will not reduce reliability at all. 
Setting the cache to a very large size (256K, for example) could, under certain 
situations, reduce DiskFit performance. 

• Partitioned Hard Disks 
The best way to back up a partitioned hard disk is to back up each partition to its own 
SmartSet instead of treating each partition as a single file and backing up the entire 
hard disk at once, as some partitioning software allows. Backing up each partition to a 
separate SmartSet provides better error handling and an efficient incremental backup. 

This is particularly important with programs that create "soft" partitions (a partial list is 
below). These programs do not change the modify date on the partition files (the files 
with the partition information) when a partition's contents change. Incremental 
backups are partially based on the file's modified date and therefore may not accurately 
reflect changes made within the partitions. 

Note that DiskFit 2.0 will automatically exclude partition files created by FWB Hard 
Disk Partition, SUM HD Partition, Infosphere MacServe, ALSoft MultiDisk, and 
Connectix Virtual Swap. 

• Files Contained in an Applications or Documents SmartSet 
DiskFit determines which files to back up to an Applications and System Files 
SmartSet by following two rules: 

-All files of type APPL are copied. 

-Any files listed in resource PAR#, ID = 128 are copied. 

The PAR# 128 list contains help files for common applications and system files. 

DiskFit copies all files to a Documents SmartSet that would not be copied to an 
Applications and System Files SmartSet. The only exception is that files listed in the 
P AR# resource, ID = 130 are never copied. This list contains only DiskFit Info and 
tape cache files. 

BACKUP STRATEGIES AND CONSIDERATIONS 39 



40 

Note that you can always exclude files by Type and Creator codes as described in the 
section "Exclude Files" in Chapter 3. 

• Invisible Files 
DiskFit copies invisible files (such as the Finder's desktop file) both to SmartSets and 
Duplicate volumes. Invisible files copied to a SmartSet are made visible on SmartSet 
disks and invisible again during restore. 

If you use the Finder to copy files from a SmartSet disk that were originally invisible, 
they will appear visible on your hard disk. If you wish to make them invisible, you 
may do so with an editor such as ResEdit™ from Apple or with a desk accessory such 
as DiskTop from CE Software. 

• Contiguous Files 
Whenever possible, all files are copied contiguously, meaning that they are stored in 
one unbroken section of the physical disk. This means that your hard disk will most 
likely be faster after a restore than it had been before. 

Occasionally large files joined manually may be placed on the disk noncontiguously. 

Questions and Answers 
Q: What happens if I am missing a disk or have a bad disk in a SmartSet backup 
or restore? 

A: If you are missing a disk or tape during an incremental backup, even if it is the 
first one, click Missing and DiskFit will automatically recopy the appropriate 
information from your source onto another volume. If you are missing a volume 
during a restore, even if it is the first one, click Missing and insert the next one. 
DiskFit will copy the available files from the rest of the SmartSet volumes. You 
will not be able to restore the files on the missing volume. If the volume is 
unreadable, you may try to read it with a disk recovery utility. 

Q: I've been making incremental backups to the same tape(s) for a while. Lately 
it takes a long time. What can I do? 

A: There are two reasons a tape backup would slow down: 

One possibility is that files are "fragmented" as the tape has become nearly full. In other 
words, there isn't enough space left on the tape to write the file(s) in one continuous pass. 
The result is that pieces of files become scattered throughout the tape-and the tape 
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mechanism takes longer and longer to search the tape to locate the file fragments. The 
solution is to erase the tape and do a new complete backup of the hard disk. 

The other possibility is that your hard disk does not have 650K of contiguous space for 
the TapeCache file. A file called "%%TapeCache%%" should be created in the System 
Folder after you insert a tape. This file is critical to efficient tape operation. If you do 
not have 650K of contiguous space on your hard disk, this file will not be created. If the 
file is not created, either use a disk defragmenting program or archive some large files to 
provide enough space for the cache file. 

Q: What do I do when DiskFit says "The current date is before the last backup 
date" ? 

A: Check to see if your Macintosh Clock and Calendar, under the Control Panel, 
are set to the correct date and time. If not, change them and proceed as normal. If 
they are correct, then they must have been incorrect the last time you backed up. 
Choose Smart Sets from the Windows menu, select your SmartSet Info file and 
delete it. Then back up and insert the first disk of your SmartSet. DiskFit 
will respond with "This is not a known SmartSet. Scan all disks?" Click Yes and 
DiskFit will rebuild the SmartSet. 

Q: I would like to Archive. Can I use DiskFitfor this? 

A: Yes, absolutely. You can create a SmartSet or Duplicate of your hard disk at 
any time and label and store it. This is essentially a snapshot of your hard disk at 
that time and date. However, be careful that you do not use this SmartSet or 
Duplicate for future backups or any changes to your hard disk will be reflected. 
Also, if there is room on your Duplicate destination hard disk you can use the 
Exclude [Folders] option to archive specific folders on this duplicate volume. 

NOTE: You cannot use Exclude {Folders] on SmartSet destination volumes. 

Q: Can I restore just one file, not a whole SmartSet? 

A: Yes. Since all SmartSets are Finder compatible, you simply drag the File icon 
from a SmartSet disk to your hard disk, instead of following the complete Restore 
procedure. You can locate your file by choosing View Report from the Windows 
menu and opening the report for the desired SmartSet. The report will tell you 
which SmartSet disk the file is on. 

If DiskFit had to split a file over multiple SmartSet disks because it was too large 
to fit on one SmartSet disk, each piece will have a Split File icon. Copy all 
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fragments of a split file into an empty folder on your hard disk. Launch DiskFit 
and use DiskFit's Join Files command in the File menu to rejoin the split file. 

For Technical Support 

If you still need help, call SuperMac Technical Support at (408) 245-0646 or FAX 
(408) 732-2696 for assistance, or you can log onto the SuperMac BBS at (408) 
773-4500. You can also find technical assistance in the SuperMac RT on GEnie, 
the SuperMac section on CONNECT, in APVENB, sUbtopic 16 on 
CompuServe, the SuperMac bulletin board on AppleLink®, or the SuperMac 
Forum on American Online. 
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CHAPTER 7 

TROUBLESHOOTING 

This chapter offers some suggestions for common DiskFit problems. DiskFit has 
undergone extensive development and testing to minimize the occurrence of problems. It 
displays informative messages if an error should occur. If you encounter a problem, read 
the error message. Choose Help from the Windows menu for a list of error messages and 
an explanation of each one. 

DiskFit was designed to overcome many common problems. If it has trouble writing a 
file, DiskFit will notify you and try again, writing to different disks if necessary, until it 
copies the file successfully. Even if DiskFit is unable to read a particular file, it will 
inform you and move on to successfully back up all other files. 

If DiskFit is unable to continue a backup, try returning to the Finder and running it again. 
If the problem persists, then try shutting down and turning off your Macintosh and 
starting again, or use a different program to see if it exhibits a similar problem. If the 
problem appears to involve only DiskFit and not your hardware or other software, check 
to see if the symptoms are similar to those described under "Power Failure/Reset" below, 
and follow those instructions. 

If you are backing up to tape and operations are extremely slow, make sure a file called 
"%%TapeCache%%" is created in the System Folder after you insert a tape. This file is 
critical to efficient tape operation. If you do not have 650K of contiguous space on your 
hard disk, this file will not be created. If the file is not created, either use a disk 
defragmenting program or archive some files to provide enough space for the cache file. 

Bad 3.5-inch disks often give some indication of trouble before they fail completely. If a 
disk generates an error, even if it subsequently appears to work correctly, we suggest that 
you replace it. DiskFit has a "Missing" button that allows you to do this very easily. The 
next time DiskFit asks for the disk, click Missing and insert a new disk. If you want to 
ensure that DiskFit asks for a disk, you may tum on Scan All Disks in the Options menu. 
You may turn off that option as soon as you have rebuilt the problem 3.5-inch disk . 

• Resuming 
DiskFit was designed so that if you choose Quit in the middle of a backup or restore, 
you can continue where you left off. The next time you launch DiskFit, insert the first 
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SmartSet destination disk when you are asked to choose the destination volume. 
DiskFit will know how many disks were already updated, and ask for the next one in 
the series without having to rescan the updated ones. 

• Out of Disks 
If you do not have enough volumes to complete a backup (DiskFit does not care if you 
mix and match types of backup media in a single backup), you may choose Quit and 
automatically resume right where you left off the next time you run DiskFit. The next 
time you launch DiskFit, insert the first SmartSet destination disk when you are asked 
to choose the destination volume. DiskFit will know how many disks were already 
used, and ask for a new one without having to rescan the used ones. 

• Missing a Disk 
If you are missing a disk or tape during an incremental backup, click Missing and 
DiskFit wiII automatically recopy the information onto another volume. If 
you are missing a volume during a restore, click Missing and insert the next one. 

• Will Not Read a Disk during a Backup 
If you insert a SmartSet disk and get the Eject/Initialize alert, try ejecting the disk, 
checking to make sure it is the right one and inserting it again. If you still are asked to 
Eject/Initialize, eject the disk and click Missing. Then either treat that disk like a new 
one and initialize it, or substitute a different disk. 

• Done, Yet Still Wants a Disk 
If DiskFit asks for a disk that does not exist, chances are that you are rescanning or 
restoring and DiskFit has already ejected the last disk in your set. In either situation, 
DiskFit has no way of knowing when it reaches the last disk. Just click Missing and 
then click Done. 

• Power Failure/Reset 
Normally if the power goes off or the Reset button is pressed during the middle of a 
backup, running DiskFit again will allow you to continue right where you left off. 
There are a few cases, however, when a power failure or pressing the Reset button 
might cause a problem with the DiskFit Info file. In such cases, DiskFit may crash 
(display a bomb box) when you launch it or try to use or create a SmartSet. If this 
occurs, move the DiskFit Info file in your System Folder to the Trash. You will have 
to rescan your SmartSets, but that does not take long. 

If you still need help, please call SuperMac Technical Support at (408) 245-0646. 
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CHAPTER 8 

REFERENCE 

The DiskFit screen contains a message area, the selected volume area, and a volume list. 
The volume list itemizes all hard disks, 3.5-inch disks, partitions, file server volumes, 
tapes, Bernoulli cartridges, etc. that are currently mounted. 

If you wish, you may eject, rename or erase the currently selected volume. A confirming 
message is displayed before erasing. If you rename or erase a SmartSet disk, it will no 
longer be considered a SmartSet disk. 

The Apple (tI) menu contains "About DiskFit" and whatever desk accessories you have 
installed. "About DiskFit" will tell you what version of the program you have. 

The File menu contains the following options: 

• Close 
Closes current window. 

• Disk Duplicate 
Duplicates the selected disk. Manually specifies the Duplicate operation for any disk, 
where the source is copied precisely to the destination with folder hierarchy and 
desktop file intact. If the source will not fit on the destination, you are asked to 
confirm, and then all files that will fit are copied. The Duplicate operation also occurs 
without confirmation whenever a backup operation occurs between two large volumes 
and the source will fit entirely on the destination. 

• Join Files 
Allows you to do manually what DiskFit will otherwise do automatically. To manually 
join a file, use the Finder to copy each piece of the file to be joined into the same folder 
on your hard disk. Very little extra disk space or memory is required. Launch 
DiskFit-by double-clicking the Split File icon, if you wish-and select Join Files 
from the File menu. Locate the folder that you copied the split files to and select the 
file that you wish to join. Click Join. 

• Eject 
Ejects the current volume, if ejectable. Otherwise this button is dimmed. 
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• Page Setup 
Contains various options for printing the report. 

• Print Report 
Allows you to print a report from within DiskFit. 

• Quit 
Quits DiskFit and returns you to the Finder. 

The Edit menu contains the normal clipboard commands. 

The Windows menu contains four items: 

• Help 
Shows a list of topics. Opening or double-clicking a topic brings up a short text on 
that subject. 

• SmartSets 
Displays information on all SmartSets that DiskFit is keeping track of, and allows you 
to delete obsolete SmartSet information and change the selected folders and files in an 
existing SmartSet. 

• View Report 
Allows you to open and view a report on a backup. This is handy to determine where 
particular files are located in a SmartSet. 

• Error Log 
Keeps a record of any special messages or errors that occurred during the current 
session. If an error occurs, the last message of the backup or restore will be "Backup 
[or Restore] completed with errors." 

• Clipboard 
Opens the Clipboard window. 

The selections in the Options menu allow you to change certain backup specifications. 
Normally you would leave these at the original settings. Any changes you make are 
preserved until you change them again. 

• Verify Writes 
Performs an extra verification of the backup in addition to DiskFit's normal 
verification. Verify Writes makes the backup about 30% slower. Originally set to off. 
In general, this option is most useful when backing up to 3.5-inch disks. 
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• Sounds 
Turns the program sounds on or off. Sound volume is determined by the Control 
Panel. 

• Scan Every Disk 
The Scan Every Disk option, available during incremental backups only, allows you to 
verify the integrity of your SmartSet by checking every disk. When it is checked, 
DiskFit requests each disk in the SmartSet whether or not it needs to be modified. Scan 
Every Disk is useful if you suspect that one or more SmartSet disks have been 
modified, damaged, or lost since you last backed up. Originally set to off. 

Whenever DiskFit requests a disk, you may either insert it or click Missing and rebuild 
its contents on a new disk. You may rebuild the contents of any missing disks, or bring 
up to date any disks that have been modified outside of DiskFit. 

• Auto Format 
Causes DiskFit to check for blank floppy disks. If an inserted disk has never been 
formatted, DiskFit formats it to be as large as possible given available formatting 
possibilities (i.e., 800K for normal media, and 1440K for high-density media). Holding 
down the Option key forces a 400K format in an 800K drive. Originally set to off. 

• Fewer Safeties 
When checked, reduces the number of confirmations required to perform various 
operations. This option is to save time for experienced DiskFit users. 

• Faster Copying 
This option overrides the normal HFS copying procedure in favor of a faster method in 
which files are copied contiguously onto the backup media. Since the backup device 
heads do not have to move back and forth as much, the copying speeds up. NOTE: If 
you are backing up in the background under MultiFinder, Faster Copying will cause 
significant pauses in foreground operations. 

• Exclude [Folders] 
When checked, excludes folders with brackets around their names from a backup. See 
the section "Exclude [Folders]" for information. 

• Less Copying 
When checked, a file's modify date alone will not cause the file to be backed up. 
Instead, the file must change in size. HyperCard® and some database applications will 
constantly change a file's modify date when the file is opened, even ifthe file has not 
changed. Use this option with care, since some files may not change in size even if 
they are modified. Uncheck this option periodically to ensure full SmartSet integrity. 
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• Expanded Report 
Each time you back up, DiskFit Report logs the time, any errors, and the result, and 
creates a list of the folders and files on your hard disk and the SmartSet disks where the 
files can be found. DiskFit Report is a text file that can be read by choosing View 
Report from the Windows menu or with any word-processing program. The report 
can be printed from within DiskFit by choosing Print Report from the File menu. 

• Normal Report 
Same as Expanded Report, without the file location information. 
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GLOSSARY 

Auto Format: A command available on the Options menu that initializes disks that have 
never been formatted to their appropriate size, 400K in a single-sided drive and 800K in a 
double-sided drive, and depending on the disk type, 800K or 1440K in an FDHD drive. 

Backup strategy: The backup technique you use regularly to ensure the integrity of files 
and data on your hard disk. 

Destination volume: The disk that DiskFit will copy onto; a backup disk during a 
backup, a hard disk during a restore. 

DiskFit Info file: The file containing SmartSet information created automatically in the 
System Folder to speed incremental backups. Also the files containing SmartSet 
information on each SmartSet disk. 

DiskFit Report file: A text document created in your System Folder that logs each 
backup operation and reflects the correspondence of folders and backup disks. May be 
opened and/or printed from within DiskFit or with any word-processing application. 

Documents SmartSet: A SmartSet that backs up only documents, not applications or 
system files. Will include all documents created except programming source code. 

Error Log: A window containing a record of any unusual occurrences or errors during a 
backup. All of this information is also put in the DiskFit Report file. 

Format: To completely erase a disk, dividing it into tracks and sectors where 
information is stored. 

Incremental backup: The process of backing up only the files that are new or changed 
on your hard disk since the last backup. Bringing a SmartSet or Duplicate up to date. 

Initialize: Dividing a disk into tracks and sectors where information is stored. 

Join: The process of recreating a large document that was split because it would not all 
fit on one SmartSet volume. 
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Expanded Report: A log of the time, any errors, and a list of the folders and files on 
your hard disk and the SmartSet disks where the files can be found. Can be opened and 
printed from within DiskFit or any word processing application that reads text files. 

Normal Report: Same as Expanded Report, without the file location information. 

Rescan: The process of recreating a SmartSet when information has been partially lost 
or deleted. 

Restore: The process of recreating or rebuilding a hard disk, sometimes necessary after a 
problem has occurred with the original. 

Scan Every Disk: An option that requests every disk in the SmartSet whether required 
or not. Valuable if a backup disk is missing or damaged because it can be rebuilt, or if a 
SmartSet disk has been modified because it will be brought up to date. 

SmartSet: A set of disks corresponding to a volume or part of a volume for which 
DiskFit is storing backup information. 

Split file: Part of a file that has been split because it is too large to fit on one disk. 
Splitting during a SmartSet backup and joining during restore occur automatically. 

Subvolume: A folder you define to be used as a source or destination volume for backup 
and restore purposes. 

Volume: A named device that is a source of or destination for information organized 
into files. 

Volume list: The list of volumes appearing in the main DiskFit window. Used to select 
a hard disk to be backed up or restored, and to identify disks for SmartSets. 
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Disclaimer of Warranty and Limited Warranty 
If you are not completely satisfied with this software at any time during the first 30 days after you 

receive it, retum the software and manual, postage prepaid, during the 30-day time period, with 

proof of purchase to your dealer or to SuperMac Technology, 485 Potrero Avenue, Sunnyvale, CA 
94086 for a full refund of the purchase price of the product. At your option, you may include a 

description of the source of your dissatisfaction. 

If you discover physical defects in the media on which this software is distributed or in the manual 

provided with the software, SuperMac will replace the media or manual at no charge to you, 

provided you return the item to SuperMac Technology during the 90-day period after you received 

the product. 

Except as specifically stated above, neither SuperMac Technology nor Dantz Development 

Corporation make any other warranties, express or implied, with rcspect to the software, media, or 
manual including (but not limited to) implied warranties of merchantability and fitness for a 

particular purpose. 

APPLE COMPUTER, INC ("APPLE") MAKES NO WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE 

APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 

REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE CURRENTNESS 

OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF 
THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF SOME 

WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY 

NOT APPLY TO YOU. 

The warranty and remedics set forth above are exclusive and in lieu of all others, oral or written, 
express or implied. No SuperMac Technology dealer, agent or employee is authorized to make any 

modification, extension, or addition to this warranty. 

In no event will either SuperMac Technology or Dantz Development Corporation be liable for loss 
of profits or good will or other direct, indirect, incidental, or consequential damages resulting from 

any defect in the software, media or manual, even if advised of the possibility of such damages. 

SuperMac Technology's and Dantz Development Corporation's liability for damages to you or 

others will in no event exceed the total amount paid by you for the product. In particular, neither 
SuperMac Technology nor Dantz Development Corporation shall have any liability for any 
programs or data stored in or used with SuperMac Technology's products, including the costs of 

recovering such programs or data. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES, OR AGENTS BE 
LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES 
(INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, 
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LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 

INABILITY TO USE THE APPLE SOFTWARE, EVEN IF APPLE HAS BEEN ADVISED OF 

THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW 

THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 
INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or 

limitation of implied warranties or liability for incidental or consequential damages, so the above 

limitations or exclusions may not apply to you. This warranty gives you specific legal rights, and 

you may also have other rights that vary from state to state. 

OISKFIT USER'S MANUAL 
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KEY FEATURES: 

• Incremental backup: OiskFit automatically scans for 
files that have been removed from your hard disk, and 
then reclaims space in the backup so it can be used for 
new files. Since new files aren't merely "tacked on" at the 
end of the backup media, storage space is conserved, and 
future backups remain fast, efficient and precise. 

• Widest choice of backup media: OiskFit is compatible 
with standard 3.5" disks, the new Apple FDHO SuperOrive 
1.4 Mg floppy disks, 3M OC-2000 tape units, Kodak/OTC 
and Bernoulli cartridges, and hard drives. 

• Select type of files for backup: Select documents only, 
systems and applications only, or specify a particul~r file 
for backup. OiskFit also has an Exclude Folders option, so 
specific folders can be excluded from the backup process. 

• Finder-readable storage format: Backs up files in stan
dard Macintosh'" format, so they are always accessible 
from the Finder:" No need to run a special program to 
retrieve your files. 

• Other features: OiskFit also runs under MultiFinder,'" gen
erates reports and error logs, estimates the number of disks 
required , and automatically formats and initializes disks. 

Backing up 500K of new and revisedftles: 
Finder · 22 mill. Brand X • 8 mill. DiskFit = 3 min. 

Backillg liP with DiskFit takes jllst a few milllltes a day. blsert 
the disks as they are reqllested, alld DiskFit does the rest 

UnHkeotber 
backup programs, 
DiskFit's backup 
floPPY disks 
remain a 
manageable size 
-even after 
montbsof 
incremental 
backuPs. 

Brand X • 32 disks Inittal8Mb backup; 
tben backing up 
50K ofcbangesl day 
foramontb. 

DiskFit = 12 disks 

Insure Yourself 
Against Data Loss 
Backing up your hard disk is something you know 
you should do every day - but you probably don't 
bother. With DiskFit;" backup becomes so simple 
you won't mind doing it regularly. Here's why: 

DiskFit is Fast and Automatic 
DiskFit automates the entire backup process. Simple, 
Macintosh-style controls guide you through the 
entire procedure. Then, with subsequent backups, 
DiskFit prompts you to insert only the disks 
required to create an exact copy of your hard disk. 
DiskFit will even prompt you to insert disks in the 
background under MultiFinder! 

DiskFit is Reliable 
DiskFit works on a file-by-file basis, and verifies 
the integrity of each file as it's stored on the disk. 
Every backup disk contains a directory of its own 
- no separate directory disk is needed. If a backup 
disk is lost or damaged, DiskFit can automatically 
recreate it from the files on your hard disk. 

DiskFit. 
The complete backup solution. 

System requirements: 

Macintosh 512K Enhanced, Macintosh Plus, SE or II; with HFS hard drive. 
Tape Backup requires 3M DC2000 tape units. 

~SUPERMAC 
485 Potrero Avenue 
Sunnyvale, CA 94086 
(408) 245-2202 

Macintosh, Finder and Mu~iFinder are trademarks of Apple Computer, Inc. 
©1988 SuperMac Technology. All rights reserved, 
including the look and feel of the product. 3001752-0001 Rev. C 

THIS PRODUCT BACKED BY OUR 

30-DAY 
MONEY BACK 
GUARANTEE 
SEE MANUAL FOR DETAILS o 8 



Utility Software 

OiskFit v2.0 
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